Best Practices for SAS® Business Intelligence Administrators: Using the Configuration Troubleshooter to Keep SAS® Solutions and SAS® BI Applications Running Smoothly
Tanya Kalich, SAS Institute Inc., Cary, NC

ABSTRACT
There is a tool that will help pinpoint access problems, check that security has been implemented correctly, debug WebDAV configuration issues, monitor the health of the Web application server, and more for your SAS® Business Intelligence installation. It will even allow you to create checks of your own, comparing configuration files to standards that you define. This tool is the Configuration Troubleshooter, and it is invaluable for creating and maintaining a smooth-running BI environment. This presentation will teach you how to use the Configuration Troubleshooter for maintenance and troubleshooting. Using case studies collected from SAS Technical Support, we will step through the process of problem discovery, investigation, and resolution using this tool.

Keywords: configuration troubleshooter, administration, business intelligence, troubleshooting, logs, install, deploy, metadata, portal, Xythos, WebDAV, report, SAS Web Report Studio, solutions, BIP tree, SAS administrator

WHAT IS THE CONFIGURATION TROUBLESHOOTER?
The Configuration Troubleshooter is a plug-in for SAS® Management Console that is used to query and display your site’s configuration of the SAS Business Intelligence environment. The Configuration Troubleshooter gathers configuration data from three main sources: the SAS® Metadata Repository; Web servers and Web application servers; and configuration files. It then displays this data in a window for review and interpretation. With the information in one location, you can easily examine configuration and setup information, pass it to SAS Technical Support, or store it for later use.

Almost as important as what the Configuration Troubleshooter does is what it does not do; it does not make any configuration changes to your SAS Business Intelligence platform. This makes it safe for beginners as well as experienced SAS Administrators to use.

HISTORY
The Configuration Troubleshooter was initially created for developers of SAS BI products to use internally. It was first used with SAS® Web Report Studio to pinpoint early configuration problems. This small tool was useful enough that it was passed to SAS international consulting divisions. They found it so useful that it was developed into a product to help SAS customers troubleshoot and report on their own SAS BI configuration issues.

The Configuration Troubleshooter is now at version 3.1. The two most important additions in this version are the expanded online help and the new ability to download changes or updates from the SAS Customer Support Web site. Another addition in version 3.1 that is useful for some sites is the optional Web agent. This agent reads configuration files that are not available over a network-mapped disk drive. It is a small Java Web application that can be installed on any of the three Web application servers (Tomcat, WebLogic, or WebSphere) supported by the SAS BI Platform.

STRUCTURE
There are three concepts to the structure of the Configuration Troubleshooter:
- **Rules** – the basic unit of inquiry in the Configuration Troubleshooter
- **Models** – collections of Rules
- **Profiles** – the structure that the Configuration Troubleshooter uses to store information about your particular BI configuration.

Rules
Each rule performs one of three basic tasks:
- **Comparison Rules** compare a configuration value to a constant or to other configuration values.
- **Display Rules** are simple reports of values, such as a list of ports.
- **Information rules** display a list of troubleshooting tips for a particular error or product.

The configuration values for Comparison and Display Rules can come from a configuration file, the SAS Metadata Repository, or a Web server / Web application server.
The example in Display 1 shows a *Comparison Rule* that compares the SAS Workspace Server property *Currently running*, on the left, with the constant *true*, on the right.

**Display 1. Workspace Server: Server is Running**

We see by the green check that the values match.

The example in Display 2 shows a *Display rule* that lists all of the assigned ports that are known to the SAS Metadata Server.

**Display 2. List of Ports**
The example in Display 3 shows an Informational Rule that lists troubleshooting steps for the WebDAV configuration.

Display 3. WebDAV Informational Rule

Models

Models are groupings of rules designed to address a specific task. For convenience, we describe three general categories, although the underlying structure of all models is the same:

- **Error Models** are used to diagnose a particular error.
- **Diagnostic Models** are used to support general troubleshooting.
- **Exploratory Models** are used to observe the system’s current state.

When using Configuration Troubleshooter to investigate a SAS BI environment, the SAS Administrator selects and runs a model. The results of the model are displayed in a summary screen that indicates a result status of OK, problem, or "check it out" for the Comparison and Display rules that are included in the model. The SAS Administrator can then choose to view the detailed results for any of the rules included in the model.

A "manager" option in Configuration Troubleshooter enables the SAS Administrator to view all of the rules and all of the models defined in the system. An administrator can create and name custom models by grouping existing rules, and advanced users can create new rules. Although the Configuration Troubleshooter comes with many useful predefined Models, I have found it most useful to make my own groupings. We’ll briefly cover an example of creating a custom model in "The Configuration Troubleshooter Manager" section, below.

Profiles

The Models that are listed when you open the Configuration Troubleshooter depend on your Profile, which is a list of the servers and applications that you will be checking. Configuration Troubleshooter can maintain more than one profile, for example, to distinguish between development, test, and production environments. There is a Profile wizard that allows you to specify which servers and which BI applications you will want to use with the Configuration Troubleshooter. Once you have defined a profile, you can start executing models, viewing results, and even saving them for later reference, as described in the case studies below.
CASE STUDIES
To demonstrate the process of problem discovery, investigation, and resolution using the Configuration Troubleshooter, we’ve collected five case studies from SAS Technical Support. Each case study focuses on one element of the process.

• Case Study 1: Gather information to facilitate setting up a firewall for a production deployment. Use the pre-defined Server model to describe the distribution of SAS servers, ports, and access to each server.

• Case Study 2: Investigate potential permission problems that could be causing a user’s inability to access some of the functionality of a SAS solution. Use the pre-defined Users model to help analyze user assignments, file permissions, and permission group assignments.

• Case Study 3: Investigate an intermittent problem that periodically prevents a user from accessing tables in a library defined in the SAS® Metadata Server. Use the pre-defined Library model to analyze library assignments, associations, and permissions.

• Case Study 4: Investigate potential conflicts in the WebDAV environment. Use the pre-defined WebDAV model to compare configuration settings with typical or expected values.

• Case Study 5: Gather information to facilitate moving a repository to a different environment, such as a bigger host server, or updated hardware. Use the predefined General Repository Migration model to identify and explore configuration files and identify settings that need to be reviewed or revised in order to support the new environment.

CASE STUDY 1: USING THE SERVERS MODEL WHEN SETTING UP A FIREWALL
One of our customers was setting up tighter security on his production system. He needed to know what SAS servers were running, where they were running, what ports they were using, and who had access to each server. Gathering this information might be an annoyance for an experienced SAS BI administrator, but it was overwhelming for the unfortunate user whose job was just to install a firewall. Server model to the rescue (Display 4)!

Display 4. Server Model

We showed the user how to select and use the Server model in the Configuration Troubleshooter plug-in for the SAS Management Console, shown in Display 4. The summary of results is shown in Display 5. Each row lists one rule. The result obtained from running each rule is displayed graphically in the column on the right.
Display 5. Results of Running the Server Model

Of course, we want the details. Detailed results for rule 1 are pictured in Display 6 which shows the servers and the machines that host them.

Display 6. Details of Rule 1, Servers and Hostnames
Display 7 contains a listing of the ports for the servers that are defined to the metadata repository. Notice that you can expand the window to see all of the servers listed or scroll through them using the scroll bar on the right.

Display 7. Servers and Their Ports

Display 8 shows the list of the authentication domains associated with each server.

Display 8. Servers and Authentication Domains
This last rule, shown in Display 9, lists all of the supported users for each server. After less than 15 minutes of research, our firewall installer knew which users needed to be able to use which servers through which ports.

### Display 9. Supported Users

**CASE STUDY 2: TROUBLESHOOTING PERMISSIONS WITH THE USERS MODEL**

A customer called SAS Technical Support because he was unable to use some of the functionality of the primary product I support, SAS® Marketing Automation. I knew that other customers at this site had been able to use the missing functionality, so I suspected a permissions problem. We ran the Users model in his Configuration Troubleshooter, focusing on the first two rules in particular. We looked at Rule 2 first, because so many problems that at first appear to be BI Platform issues later turn out be UNIX directory-permissions problems (Displays 10 and 11).

### Display 10. Results of Running the Users Model
This rule lists all of the SAS users that are registered in the SAS Metadata Repository on the left. On the right side of the window, all of the logins known to the SAS Metadata Repository are listed. This rule enables us to select a user and then see which operating system logins are associated with that ID. In Display 11, we can see by the green check on the right that testUser is associated with the operating system login sasdemo. We kept our setup very simple, but it’s possible for a given SAS user to have multiple logins for multiple domains.

We can also use this rule to see which SAS IDs are associated with a particular operating system login. To do this, we select a value on the right and view the green-checked values on the left. In this case, we found the operating system login for our SAS user, and then checked the file permissions to make sure that the login ID was allowed by the operating system to read and write in the necessary directories. It was.

That didn’t solve our problem, so next we took a look at the permissions group assignment for the user. SAS Marketing Automation has two special permissions groups that control what a user is allowed to do. The rule shown in Display 12 lists all SAS BI users on the left and all SAS BI groups on the right. When you select a user, green checks appear to the right of all of the groups associated with that user. Similarly, when you select a group, green checks appear to the right of all users that are in that group.
Bingo! Our user was not in the correct permissions group. We used the User Manager Plug-in in the SAS Management Console to assign him to the MarketingAutomationAdvancedUser group, and this immediately solved his problem!

CASE STUDY 3: USING THE LIBRARY MODEL

Our next problem is a strange situation at a customer site where users appeared to intermittently lose access to the tables in a library that was defined in the SAS Metadata Repository. The problem did not seem to be related to the user or the time of day. We ran the library diagnostic, which checks the following:

- which libraries are preassigned
- which libraries are associated with which Workspace Server (that is, which server context)—for example, a SAS/SHARE® server context versus the SASMain context
- which users have been granted direct read permissions for a given library (Neither this rule, nor the group permissions rule, traces inherited permissions.)
- which groups have been granted direct read permissions for a given library

We ran the Diagnostic model for this particular library by choosing Run Model with User Input when asked, and then as shown in Display 13, specified the library, telco.
Running this model, we could see that the users and groups all had the appropriate permissions. We asked the System Administrator to check the operating system permissions, to see if they had been changed, and they had not. We then looked at the rule Library, as shown in Display 14.

Display 14. Library Is Preassigned Rule

This library was, indeed, preassigned. This came as a surprise to the customer who had called in the problem. He explained that rather than preassigning the library, they defined the library in their user-defined code that ran within our application. These two library definitions were interfering with each other, confusing the SAS Metadata Server into closing the library after the user-defined code completed. Once the library was closed, it no longer acted like a preassigned library. The customer decided to stop using this libname in his code and the problem disappeared.

CASE STUDY 4: GETTING WEBDAV UP AND RUNNING USING THE WEBDAV MODEL

Many of our BI client applications rely on a WebDAV server to store and manage text files. Recall that WebDAV stands for Web Distributed Authoring and Versioning. It can be thought of as a Web-accessible file server. The SAS® Information Delivery Portal, SAS Web Report Studio, and SAS Marketing Automation all use WebDAV to enable users to manage and share BI files. When a customer called SAS Technical Support and was unable to use SAS Web Report Studio or SAS Marketing Automation, we suspected the WebDAV server was incorrectly configured. Fortunately, we have a diagnostic model set up to help you get this server up and running within the BI Platform.

Display 15 shows the tests that are performed for each of the rules in the WebDAV model.
Display 15. Tests for the WebDAV Model

As Display 16 illustrates, the details for the first rule show the Web address that has been defined for the WebDAV server.

Display 16. Web Address Defined for the WebDAV Server

If you type that Web address into a browser while your WebDAV server is running, then type in your SAS Administrator user ID and password when asked for authentication, you will see a list of directories and files served by the WebDAV server. In our customer’s case, this check went fine. We knew that the WebDAV server was functioning and was accepting the customer’s SAS Administrator user ID.
Many of the other rules compare the definition of the WebDAV server under the SAS Management Console Server Manager to various values to make sure everything connects appropriately. As Display 17 shows, Rule 2 compares the path expected by the BI Manager BIP Tree to the Server Manager definition. As it turned out, this was the problem with the customer's configuration.

![Rule 2 Image]

Display 17. Details of Rule 2

To perform the same check without the Configuration Troubleshooter, the customer would have had to go to BI Manager plug-in ► BIP Tree. Then, right-click BIP Tree and select Properties, then select the Content Mapping tab (which is shown in Display 18).

![Display 18 Image]

Display 18. Details of the Content Mapping Tab
As shown in Display 19, to get the right side of the comparison, the customer would have to go to Server Manager ➤ HTTP DAV Server. Then right-click HTTP DAV Server, select Properties, and then select the Options tab.

As shown in Display 15, the third rule in the WebDAV model checks that WebDAV is supported by the HTTP Server. To get this information, the customer would view the HTTP DAV Server Properties as shown in Display 19, highlight the listed Base Path, click Edit, and check that the base path and Supports WebDAV properties were correct. For all of this, you’d need to know what you’re looking for and be able to remember where to find it.

Display 19. HTTP DAV Server Properties Options Tab

The other rules are similar, except rules 7 and 9. Rule 7 is an informational rule that gives further troubleshooting hints for WebDAV configurations. Rule 9 contacts the HTTP server to make sure it is running. The problems with WebDAV configuration are so much easier to solve when all of the details are laid side by side by in the Configuration Troubleshooter, but are tricky without the Configuration Troubleshooter.

CASE STUDY 5: MIGRATING A REPOSITORY USING THE GENERAL REPOSITORY MIGRATION MODEL

The final case study focuses on migrating a repository. It is not uncommon for customers to call and let us know that they are moving their repository to a bigger server or merely retiring their old one. But the names of the servers are stored in places the customer doesn't even remember, throughout the metadata repository. What do we do? We run the General Repository Migration diagnostic model.

When the model is run, the first thing it does is ask where to search for the configuration files. If you happen to know where these files are, you can enter the exact location. Otherwise, enter the path to the /Lev1 directory on the SAS Metadata Server machine and the Configuration Troubleshooter will do the rest. The results will most likely appear as all yellow triangles, as shown in Display 20. The yellow triangle denotes information that needs to be examined by a SAS Administrator in order to be interpreted.
There is not sufficient space to go into each of these rules in depth, but I will show details of one of these rules. As shown in Display 21, Rule 8 gathers and displays all of the login IDs, allows you to sort by domain, and puts a red X by any of the login IDs that do not have the same domain as the highlighted repository.

Display 21. Details of Rule 8

The detailed configuration information displayed for any of these rules can also be stored for later reference by creating Batch Inputs and Batch Results. Note: Creating Batch Inputs and Batch Results is beyond the scope of this talk, but they are well documented in the online help.
THE CONFIGURATION TROUBLESHOOTER MANAGER

The Configuration Troubleshooter Manager allows you to view all of the rules at once, create and name your own models by grouping rules as you like, and even allows the advanced user to create new rules.

To get to the Configuration Troubleshooter Manager, right-click Configuration Troubleshooter and select Manager, as shown in Display 22.

Display 22. Accessing the Configuration Troubleshooter Manager

In the next window, select File ► Rules, as shown in Display 23, to see all of the rules.

Display 23. Accessing the Rules in the Configuration Troubleshooter Manager

The window shown in Display 24 normally comes up with a list that shows ALL of the rules. To see a specific subset of rules, we can choose filters and then click the Filter Rules button. The results of setting such a filter are shown here.
We can then choose **File ➤ Models** to create a model of our own that contains all of these rules. Similarly, we could create a model that contains all HTTP rules.

**CONCLUSION**

As you can see, the Configuration Troubleshooter can be a powerful time-saver. The models we covered in this paper, and many more, can even be run in batch so that the health of the system can be monitored and documented automatically. You can use the Configuration Troubleshooter models to solve problems on your own or share your results with SAS Technical Support if your system ever has a problem that you are unable to solve on your own. The ease of looking at historical and current data across the entire BI Platform makes pinpointing the source of any problems faster and more accurate.

The Configuration Troubleshooter is still early enough in its lifecycle that customers like you can make a difference in how it develops. You can do this by providing feedback on how we can make it more useful for you, as well as by submitting rules, models, and anecdotes of your Configuration Troubleshooter experience.

**CONTACT INFORMATION**

Your comments and questions are valued and encouraged. Contact the author at:

Tanya Kalich  
SAS Institute Inc.  
SAS Campus Drive  
Cary, NC  27513  
Work Phone:  
E-mail: Tanya.Kalich@sas.com

SAS and all other SAS Institute Inc. product or service names are registered trademarks or trademarks of SAS Institute Inc. in the USA and other countries. © indicates USA registration.  
Other brand and product names are trademarks of their respective companies.